Pro Tools Study Notes 2
Using Inserts
4 kinds of processing: TDM, HTDM, RTAS, AudioSuite

Only TDM is DSP-chip based; rest use computer’s CPU.

Only AudioSuite is NOT real-time

On ver 6.9 and below, RTAS can only be used on an Audio track.  LE systems allow it on Aux, Master too.

HTDM plug-ins function just like TDM but use host CPU, but are still available only on TDM systems.

RTAS restrictions: not available “below” TDM/HTDMs (ver 6.9 and down only) That is, they must be first (above) any TDM/HTDM plug-ins).  Also, RTAS plug-ins bypassed (on TDM systems) when track is record-enabled or not set to auto-voice.

HD/TDM systems: up to 128 internal sends and busses


Plus availability of hardware inserts/sends


limited only by # of I/O audio interfaces

LE systems: up to 32 internal sends and busses and 


hardware inserts/sends limited by H/W I/O

Inserts

Up to 5 on any Audio track, Aux track or Master fader.

Processed in order from “top” to “bottom”, A-E

Are Pre-fader EXCEPT on Master Faders (post-fader).

TDM plug-ins: very low latency, can be very complex,


no impact on system performance (CPU)

RTAS used on TDM systems to free up DSP power for 

other or more complex uses

HTDM – since they can be placed on Aux tracks, they are 


useful for HOST-BASED virtual instruments

You can use a stereo effect on mono track, which converts output to stereo.

Hardware inserts: can be used to allow use of outboard gear for processing signals.  

You must assign the output and input using the SAME numbered hardware I/O in/out. E.g. you assign insert B to I/O 5, you use #5 input and #5 output.

Also, hardware inserts must use previously unassigned input/output number(s).

A stereo track will automatically give you choices of hardware I/O pairs for outboard insert processing.

You do not delete inserts; you select “no insert”.

Specific Inserts that are on TDM systems only:

Pitch


Time Adjuster (adjusts for routing delays)

Insert called “trim” is gain changer + phase changer

Others (LE & TDM) include Click, D-verb, Dither, various Dynamics plug-ins, EQs, Delay, and Signal Generator.

If you want to “burn” a real-time effect to an audio file, record track’s output to another’s input, or bounce to disk.

Mono track – many effects have mono and stereo versions.  Using a Mono-to-Stereo plug-in “turns a mono track into stereo” sort of:  it will have 2 panners, 2 meters.

Track will still be mono in the sense that it has ONE input, but it must have a PAIR of outputs.

Multi-Channel plug-ins: apply same effect, with identical settings, to all channels.  

Multi-Mono plug-ins: allow (the option of) each channel in a stereo or multi-channel track, having different plug-in settings. Master link button must be turned off to adjust channels separately. (See Linking below)

Reminders – on HD/TDM systems:

ORDER: Remember that RTAS plug-ins must 

precede any TDM/HDTM plug-ins (ver6.9 and below only). On ver 7 and up it is still a good idea to follow this rule – otherwise there is a significant increase in latency on that track.

RTAS only usable (on TDM systems) on auto-voiced tracks.  

RTAS plug-ins cannot be used for Aux/Master on TDM systems

You can move insert from one place to another, one track to another – if one already exists in the destination “spot”, it will be deleted and overwritten by what you dragged in.

Plug-ins can be inserted/changed/deleted during playback, but not during recording, with some restrictions:


Can’t drag/copy plug-ins during play or rec


Can’t insert/remove mono-to-stereo during play


Can’t replace one type with another during play


Can’t remove one that has automation

The Plug-In Window
It initially comes up when you add an insert to a specific track, but it actually allows you to manipulate any plug-in on any insert on any track!

Bypass button disables currently selected plug-in.  Allows you to compare track with and without this insert.  The insert shows as “blue colored” if it is currently bypassed.

You can bypass via Inserts view by Command (ctrl)-clicking on the insert.

You can convert between TDM and RTAS, but with the previously listed restrictions (above).

Target button – if lit (red), any other insert opened will replace its window in place of this one.  If unlit (grey), future inserts will each open in their own window, leaving previous insert windows as they were.

Linking – applicable to multi-mono plug-ins only.  Master Link (2 chain links icon) turns on linking of all channels versus ability to set each channel separately.

To see all channels, Option (alt) click the Channel selector

If you re-link later, you’ll be asked which channel to copy parameters from (to all other channels).

EQ – 1 band – has 5 basic EQ types


Hi Pass


Low Shelf


Peak/Notch


High Shelf


Low Pass

EQ – 4 band – you can bypass any single EQ within it


By clicking one of the 4 icons on the left.

Managing Plug-Ins
Plug-in settings can be saved and imported using Plug-in Settings Files, via the “Librarian menu”, which starts out saying “<factory default>”.

Settings files are in 2 places:


The Session Settings folder (in your session)


The Root Settings folder (system-wide location)

To left of Librarian menu is tiny up-and-down-arrows; this is how you access session settings management options.


Saving files


Import settings


Set pref’s (Session vs. Root settings folder)

Nested hierarchy is possible (folders within folders)

Importing a session settings file brings the parameters into your Plug-in and makes that setting an option on the pop-up menu from then on, in this session.

You can also Copy and Paste settings parameters: copy “grabs a copy of” your plug-in’s current settings, puts them in a buffer (“clipboard”), which can be Pasted into another plug-in.

Move a plug-in and its settings to another place simply by dragging and dropping.

Copy (duplicate) a Plug-in to another insert on another track by Option (alt)-click and drag to new location.  Original stays where it was; new one has same settings as original.  If there was a Plug-in where you “dropped” this, the one that was there is deleted.

Important: Move/duplicate plug-in cannot be undone!
You can delete the currently active plug-in settings file only.  Use your computer’s OS to delete more than one file.

Monitoring Plug-in Usage (and other things!)

Windows > Show system usage

System: CPU overall usage (not very useful these days)

PCI Bus: bandwidth in use

CPU: How much of CPU used for plug-ins and other real-

time processes

Disk: how much of total disk throughput being used

TDM Time Slots: out of 512 (HD) or 256 (Mix 24)

PCI / DSP Capacity

Ways to reduce various activities if you are at/near limits:


Increase HW buffer or CPU %-age in HW Settings


Reduce active audio tracks, # of plug-ins


Thin or reduce automation


“Print” real-time effects to disk


Use bussing/aux tracks to apply effects

DSP-Induced Delays: The TimeAdjuster Plug-In

Old method: ver. 6.5 and below:

Delay can be added, up to 8,195, to compensate for other tracks having plug-in caused delays.

Command (ctrl)-click Level indicator at bottom of Mix Window, just above track name. Channel Delay amount (in samples) on this track (from plug-ins) is shown.

You apply TimeAdjuster to tracks whose delay you want to increase to match delays on other tracks.

Example: one track with inserts has a 12-sample delay shown.  Another shows 17-sample delay.  Add 5 samples of delay to the 12-second track so they’re both at 17.

(You can’t “remove” or “reduce” delay, only add it).

New method: Turn on delay compensation in playback engine dialogue – manages DSP induced delays automatically.
Using Sends and Auxiliary Inputs
5 sends per track, to hardware interface or to Busses.

Send View can show Assignments (for all 5) or details of A-E send (one at a time).

Individual send control shows Level fader and meter(s), Mute, Pan slider if applicable, pre/post fader toggle.

In Preferences…Operations, you can turn off the default that has Sends created with –infinity (-INF) level.  They’ll then default to 0 (zero/unity) level.

A mono track can have a mono or stereo send.  A stereo track can have a mono or stereo send. So there are 4 possible appearances for the Send Output Window.

Trick: if Send Output Window shows a pan slider or knob, then the send is Stereo (but the track may still be mono or stereo, indicated by one level meter or two.)  Also, the output (such as “Bus 1” or “Bus 1-2”) will indicate whether the Send is mono or stereo.

Post fader is the default.  That’s why the button is labeled “Pre” – if it’s unlit, the send is Post, if it’s lit, it’s Pre-fader.

Send Output Window – shows more details, larger slider, other controls (automation modes, etc.

Panners on a stereo send can be linked or unlinked, and when unlinked, can be normal or reversed.

Returns (Aux)
You have a send, you have to get its signal back into the system: create an Aux track!

You’ll initially get no signal from it; its input defaults to 

“No Input”.

Input is either a bus or a physical input from the audio interface.  Output can be the main mix output (such as Stereo 1-2) or any other output.

Now you can assign an Insert effect to the Aux track, so that effect will be applied to any of one OR MORE tracks that are SENT to this Aux track.  This is one way to conserve processing power, and to consolidate effects on similar groups of tracks, such as three background vocals all getting the same reverb treatment.

Sub-Mixes in Pro Tools

To create a sub-mix, there is not “sub-mix” track type.  You can use Master Faders (see below).  OR, create an Aux track, then route the tracks you wish to sub-mix via a bus to that Aux track.

This is not too different from using Sends and an Aux track to add an effect; difference is that you are simply “patching” the signal path in a different way.  You can use this Sub-Mixing method to apply FX to one Aux track and have it affect (for example) 3 vocal tracks that you are sub-mixing.

Solo-Safe Mode – useful for Aux returns and Aux sub-mixes, so they aren’t muted when you solo other tracks.  Command (Control)-click the Solo button to toggle this on and off.  ‘S’ button is grayed out in Solo Safe mode.

Master Faders

Allow control of output levels of (1) signals sent to physical Output, (2) or (2) via busses.

Another way to do sub-mixes.  Also useful for many other things such as:


Monitor the sum of all tracks going to a given 

output to make sure it’s not clipping


Control submix/submaster levels


Control stems (musical elements) for post


Controlling FX send levels


Applying inserts to all tracks sent to common Out

No DSP power used by Master Faders – use as many as you want!

Inserts are POST-fader, unlike for Audio or Aux tracks.

Therefore, useful for final Mastering of your session … add that final overall compressor or reverb etc.!

NOTE – Master Faders have no PAN controls, no Input selector, no Sends, no Mute, no Solo, etc. – just have:


Inserts


Level fader


Level Meter(s)


Output selector


Automation selector

Automating Pro Tools Sessions

Things that can be automated:


Vol, Pan, Mute – Audio, Aux & MIDI tracks


Vol, Pan, Mute – Sends


Vol – Master Faders


ALL Plug-in parameters

If group(s) are active, automation recorded to one group affects all tracks in the group.  BUT this only applies to things that are affected by Groups!  So, includes:


Vol, mute, send level, send mute.

All other automation parameters unaffected by Groups.

Playlists – important: each track has only ONE automation playlist per automatable parameter.  This means various playlist on that track will all “play” the same automation.  That is, a track’s automation applies to all playlists on that track.

Pro Tools automation is much higher resolution than MIDI automation, so it’s recommended to automate Volume, Pan, etc. instead of the MIDI track’s data.

Automation Modes - 5 Major Modes

Auto Off: no automation plays back or is recorded

Auto Read: automation PLAYS only

Auto Touch: automation writing (updating) starts when a control is touched, and stops when that control is released.  Returns to any previous automated value by “Ramping back” to this value as determined by Auto Match parameter in Preferences…Automation.

Auto Latch: writing/updating starts when a parameter is modified; writing/updating continues even after control is released (no longer touched), as long as playback continues.  Updating only stops when playback is stopped.

Auto Write: writing starts for all enabled parameters when playback starts, and only stops with playback stops (i.e. touching/releasing had no affect on when automation data is recorded or not).  Erases any previously written parameters.

Trim Mode: (TDM only)

Automation Enable Window

Windows > Show Automation Enable – control over various automation details.

Auto Suspend: toggles on/off, affecting writing of all automation parameters on all tracks.

Auto Arm: Enable/disable various kinds of automation data writing (Vol, Pan, Mute, Plug-in, Send level, Send pan, Send Mute).

Preferences…Automation – also has “group related” functions
You can enable or disable faders moving automatically as fader-level automation data is “played”. 

“Write Switches to Touch after Pass” – a good safety idea is to leave this enabled.

Also has the following Group-related switches:

Mutes Follow Groups

Solos Follow Groups

Send Mutes Follow Groups


Send Levels Follow Groups


LFEs Follow Groups

Auto Match – affects how Pro Tools returns a control (after automation writing stops) to previously written automation data.  Auto Match Time is how quickly Pro Tools returns a control’s value to previously recorded data after control is release (not touched anymore).

On tracks, to left of Track Type Icon (just above “vol” which is just above Track Name), are the Auto Match indicators.  Tell which way fader must move to get it closer to its original automation level.  Looks like two triangles, pointing in opposite directions, one above the other.

Automation writing (recording) is Undo-able.

New track placed in Auto Read mode initially.

Trick/tip: REC enable buttons do not enable/disable recording of automation – only of audio data.

Make sure (via Automation window) that parameter(s) you wish to automate are enabled before writing automation data.

To view automation data, change from Waveform view to other views (Volume, Pan, etc.)

Breakpoint - Pro Tools term for an automation value (called a ‘node’ in some editing systems)

After one pass of automation data writing, use Touch or Latch modes to add more data, without losing all your current automation data.

Regular Trimmer tool can be used to move a whole track, or selection of breakpoints up or down “as a unit”.  New breakpoints (anchor points) will be automatically added to start/end of selection if needed.

Three possibilities:

     Trim a selection to adjust breakpoints within it

     Trim in a region to trim all breakpoints in the region

     Trim outside a region to trim ALL breakpoints



(in the entire track)

Hold Command (control) key to trim breakpoints in a finer (more detailed) way.

Trim Mode (unrelated to use of Trimmer tool, above)

Only possible on HD (TDM) systems – works with the other automation modes, but allows “relative” instead of “absolute” value changes.  Called “delta value”.

In Trim mode, and if in Auto Write mode, non-trimmable parameters work as if you were in Auto Touch mode.

Differences: when Trim mode on: Auto Read mode can be used to “audition” trim changes.  Auto Write mode allows you to set delta (relative) values prior to playback.

Watch-Out: Also, in Trim mode, the preference “Write Switches to Touch After Pass” does NOT function!

Manual Write to Start/End/All

Available with the Automation Enable window.  

Allows you to write automation values that you want to maintain over long periods of time, such as from “here” to end of session, start of session to “here/now”, etc.

Only works when you are writing automation data (in “Play” mode with automation writing in Touch, Latch or Write (or Trim) modes).  Does NOT work if transport (playback) is STOPPED.

If you have a selection made, the manual-write will be to start/end/all of that selection.  Otherwise it is to the start/end/all of the session.

Auto-Write on Stop works similarly, but does its thing when you press STOP (when you stop playback).

Automating Plug-Ins
All controls of any real-time plug-in can be automated!

Clicking the “auto” button in the Plug-in windows gives you a choice of which parameter(s) you wish to automate.

Automatable parameter controls will be GREEN in the Plug-in window, in Auto Read mode; will be RED in Touch, Latch or Write modes.

Option+Command+Control (ctrl+start+alt) clicking the control will enable that control for automation.

Otherwise, it works as expected: use the Automation mode you wish, play, then change the plug-in control(s) to write automation data to the track for those controls.

Automation Safe – protects a track, send, or plug-in from having automation data recorded.  Useful when you have automation you like and don’t want to risk over-writing it by accident.  Toggle for this is in Output and Plug-in windows.

Editing and Controlling Automation

Each type of automation is stored in its own playlist, but only one of each type - even if you have multiple audio playlists.

You can “thin” automation, that is, reduce the density of breakpoints in your automation playlist(s). It reduces the # of breakpoints, but leaves enough to sonically maintain what you intended with your automation moves. This will reduce the amount of CPU resources it takes to play automation, thus it’s less taxing on your CPU.

[These breakpoints act a lot like “nodes” or “keyframes” in other kinds of editing systems].

In Preferences…Automation, you can turn on Smooth and Thin Automation After Pass, and then select from 5 degrees of thinning from None, Little, Some, More, Most.

Can be done manually (using same Degree of Thinning setting as you set in Preferences) with File > Thin Automation, or Option+Command (Alt+Ctrl) T

Graphical Editing of Breakpoints

You can do many operations on them in much the same way as you do for editing audio data.

The number of possible vertical positions for a breakpoint depends on the type of automation data.  For example, Volume, Pan, EQ Frequency each has many possible values.  Mute and EQ Type have 2 to 6 possible values so operate in a “stepped” way.

Create a new breakpoint: Click with Grabber tool.

Move a breakpoint: click-and-drag it

Nudge: select one or more breakpoints, and then nudge in the usual fashion.

Dealing with groups: Editing automation data affects Groups - Hold Control (start) key down while doing an edit to restrict it to current track (i.e. to ignore group that this track is part of) for this specific edit.

Trimmer: use to move whole groups of automation breakpoints up or down in value

Pencil: can be used for simple as well as unusual/creative ways of editing/adding automation data

Cut vs. Delete: The “Cut” command adds anchor points at the start and end of a selection; Delete key just removes the selected breakpoints.  They ARE different!

Exception: if there is no automation at all when you cut, then no anchor points will be added.

Paste: Always pastes data to the same kind of automation playlist – even if that particular automation is not currently displayed.

Paste: When you cut/copy/paste AUDIO, all automation for that audio is copied/pasted too.

Paste Special: press Control (Start) key then choose “Edit > Paste”.  Allows you to paste similar data in way normally not possible, such as Mute Track data to Mute Send, or Send 1 data to Send 3, etc.

You CANNOT interchange automation data from Audio to/from MIDI tracks, or from continuous controls to discrete controls (such as Volume data to Mute data).

Delete a Breakpoint: Option (Alt)-click it with Grabber.

Delete group of breakpoints: SELECT them, press DELETE or select Edit > Clear.

To delete ALL automation playlists (vol+pan+mute+etc., ALL AT ONCE) … Select a range or whole track(s), then press Control+Delete (Control + Backspace)

Note: when a Region is moved, its automation data is moved with it.

To suspend automation playback & recording, use “Show Automation Enable” window, click (toggle) “Auto Suspend”

To suspend automation play/rec on a track, change “auto” mode to “auto off”.

To suspend specific automation types from rec/play, choose them from Track View menu, then Command (control) click directly on Track Display Format button.  This toggles it off, or back on if it was off already.

To suspend specific automation types for all tracks, do same as above but use Command+option (control+alt) click – toggles that parameter on/off for all tracks.

Final Mixdown

Mix internally to master file, or output a mix through the hardware (physical) outputs.

Dither is a form of randomized noise, only needed when going down to a lower bit rate (bit depth), to minimize quantization artifacts.

POW-r Dither plugin can be used on Master Fader as a final processor.  20-bit and 16-bit settings.

     Noise Shaping Type 1- solo instruments

     Noise Shaping Type 2-for stereo recordings/mixes

     Noise Shaping Type 3-for full-spectrum, wide stereo

Bounce-to-Disk: the most common method of internal mixdown in Pro Tools.

   Bounces all audible (non-muted) tracks

   No extra voices required for the bounce (e.g. LE=32)

No need to make a selection; by default, Pro Tools bounces all tracks for the entire session length.  If you do make a selection, all audible tracks for the length of that selection are bounced.

All inserts, sends, automation, etc. are “played back” in real time into the bounce file, so be sure your mix is exactly as you want it before doing the bounce.

To create a sub-mix, simply mute unwanted tracks.

All tracks must output to the same output pair (for stereo), and that pair is chosen in the “Bounce Source” pulldown.

Formats/Bounce Options:

SD II format for Mac only.  Goes to 48kHz only.  WAV (BWF) is the suggested file type for most applications.  WAV supports up to whatever your system supports (Mbox: 48, Digi002: 96, HD: 192)

WMA-9 for Windows systems only. 

Quicktime is available; MP3 is an option that must be purchased.

Format: Mono, Multi-Mono, or Stereo Interleaved. 

Bit resolution: can be 8, 16 or 24.

Squeezer: for 8-bit audio only.  Applies compression, limiting, gating to improve intelligibility of dialog or other simple audio.

Conversion quality: affects re-sampling (changing from Session’s sampling rate to a different sampling rate.

Convert during/After Bounce: affects when Pro Tools does file type, sample rate and bit-depth conversion.  Safest is “After”, use “During” for simple mixes with little or no Plug-in Automation or where Plug-in Automation not critical.

Internal Bouncing using Busses

You can also route tracks to a bus, and then use a new track, set to receive its input from that bus, to record into instead of doing a “bounce to disk”.

(This is somewhat like the old days of bouncing to empty tracks on your multi-track recorder!)

If you make a selection, the recording process will stop at the end of the selection.  If you don’t, you’ll have to manually stop the recording process when you want to.

External Mixdown

Route tracks to output(s), connect output(s) to devices, and record in the “obvious way” by playing back tracks in Pro Tools, and going into Record mode on your external device.

You can use analog and/or digital outputs, and you can use as many outputs as your device and hardware can handle.  

You can even simultaneously record one mix to one set of outputs, and (via Sends), a sub-mix of some tracks to another set of outputs, and record it all to one or more physical recording devices (depending on how many tracks they can record etc.)
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